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Quick Start Guide 

Overview 

We have added detailed descriptions to every feature in this program. 
Sometimes you may wish to find answers to frequently asked 
questions without looking through the detailed documentation. In 
this section you will see answers to the most commonly asked 
questions. For detailed descriptions, there will usually be a reference 
page you can look up.  

How Do I Obtain Technical Support? 

Every effort has been made in this user guide to provide answers to 
your questions. However, for your convenience we offer technical 
support for those who require help. Please read this documentation 
carefully and if you still have questions, please contact technical 
support. The contact information for technical support is provided in 
two locations: 

Location #1 For Technical Support Contact Information: In the 
program group where your accounting program icons are kept, click 
on the icon labeled Technical Support. 
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Location #2 For Technical Support Contact Information: If you 
are in the accounting program, select the menu option called 
Technical Support from the Help menu. 

What Is a Module? 

The program is divided into modules. A module is a program that is 
a part of a larger system. For example, in an integrated accounting 
program there are several “Modules” like Inventory, Purchase 
Orders, Accounts Receivable, General Ledger, etc.  

 Important Note: Please note that this chapter might cover 
modules that you may not have purchased. Some modules are 
optional and may need to be purchased separately.  

How Do I Open/Close a Period? 

Within the exception of General Ledger, there are no options within 
each module to open or close a period. Each module operates on a 
real-time basis and DOES NOT require any opening or closing.  

General Ledger also does not require any closing. However, if 
you want to do so for security and audit trail reasons, you can close a 
period or a year in General Ledger. You can close a period by 
selecting the Close G/L Period option from the G/L menu. 

Payroll also does not require and closing. However if you use the 
payroll program to track accrual of Vacation, Holiday, or Sick pay, 
then you must select the Roll the YTD Accruals option from the 
Payroll / Year End Processing menu option. In addition, payroll 
will let you purge payroll history for a range of dates from the 
Payroll / Year End Processing menu option. 
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How Do I Enter Starting Balances? 

Here is sequence of steps to enter the starting balances. You must 
start at the top and work your way down the list. You can skip any 
steps that do not apply to you.  
 

1. Chart Of Accounts (Refer to page 125) 
2. Departments (Refer to page 127) 
3. Sales Tax Codes (Refer to page 127) 
4. Customers (Refer to page 128) 
5. Enter Open Customer Invoices (Refer to page 129)  
6. Vendors (Refer to page 131) 
7. Enter Open Purchase Orders (Refer to page 131) 
8. Enter Open A/P Bills To Be Paid (Refer to page 133) 
9. Inventory Items or Services (Refer to page 134) 
10. Enter Manufactured Items (Refer to page 135) 
11. Adjust Inventory (Refer to page 136) 
12. Payroll Employees (Refer to page 137) 
13. Property Management (Refer to page 140) 
14. Checkbook Transactions (Refer to page 146) 
15. Enter G/L Beginning Balances (Refer to page 147) 

How Do I Set Up the Chart of Accounts? 

 Important Note: If you want to set up your own General 
Ledger accounts and you do not want to use any of the default 
accounts, then you must choose this at the time you create the 
company. DO THIS ONLY IF YOU UNDERSTAND 
ACCOUNTING CONCEPTS THOROUGHLY. If you do not 
understand accounting concepts thoroughly, we highly recommend 
that you use the ready-made chart of accounts and then modify 
them. This section will tell you how to set up new accounts or delete 
existing accounts. 
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First, you will need to print out a Chart of Accounts. 

1. Click on the G/L menu. 
2. Click on the Reports menu 
3. Click on the words Chart of Accounts Listing. 
4. Print it to the printer. 
5. Research the printout and see if there are any accounts that 

you do not need. 

After you have decided which accounts you will use and which 
accounts you want to delete, you will need to do the following: 

1. Click on the G/L menu. 
2. Click on the Setup menu. 
3. Click on the words Chart of Accounts Maintenance. 
4. Type in the number of the account you want to delete and 

press Enter. 
5. Press the Delete-F8 button or press the F8 function key on 

the keyboard. You cannot delete accounts that have any 
transactions associated with them. 

6. Repeat Steps 4 and 5 for all the accounts you wish to delete. 

You have deleted the accounts you do not need. Now it is time to 
enter the new accounts you will be using. This is what you will 
need to do: 

1. Click on the G/L menu. 
2. Click on the Setup menu. 
3. Click on the words Chart of Accounts Maintenance. 
4. Type in the new number for the new account and press 

Enter. 
5. Type in the new description for the new account and press 

Enter. 
6. Choose the account type from the list of account types. 
7. Press the Save-F4 button or press the F4 function key on the 

keyboard to save the new account. 
8. Repeat Steps 4 - 7 for each new account you wish to add. 

 Important Note: If you make ANY changes in the chart of 
accounts, you will need to go to the File menu and click on the 
Company Settings and then click on Company Setup. Then click 
on the tab titled Default G/L Accounts and make sure that all these 
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accounts are in the chart of accounts by pressing the Enter key. The 
cursor will move from one account to the next until it gets to the 
Save-F4 button. Then press the Save-F4 button. 

How Do I Set Up Departments in G/L? 

In order to track multiple departments in G/L you must enable and 
set up Departmental Tracking. You can do this as follows: 

1. Click on the G/L menu. 
2. Click on the Setup menu and then click on G/L Setup.  
3. Place a check in the checkbox for “Track Departmental 

Accounting” and then click on the OK-F4 button to save.  
4. Click on the G/L menu. 
5. Click on the Setup menu. 
6. Click on the words “Department Maintenance”. 
7. Type in the Department ID and press Enter. 
8. Type in the Department Description and press Enter. 
9. Press the Save-F4 button or press the F4 key on the 

keyboard to save the new department 
10. Repeat Steps 7 - 9 for each department. 

How Do I Set Up Sales Tax Codes? 

Sales tax codes are required if you wish to deduct Sales Tax on an 
Invoice or a Purchase Order. These tax codes are also called PST 
taxes for Canadian users.  

1. Click on the menu for O/E. 
2. Click on the menu for Sales Tax Maintenance.  

  We recommend that the Sales Tax ID be an abbreviation of 
the area name or state to which that the code refers. For example: LA 
would be an ideal code for Los Angeles County. 
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3. Enter the abbreviation you wish to use into the Sales Tax ID 
field, and then press Enter. 

4. Enter your Description or Area/State name in the 
Description field, then press Enter. 

5. Enter your G/L accounts numbers in the liability and 
expense fields then press Enter. 

6. In the Tax Percent fields enter the amounts, which comprise 
the total amount of tax charged (see example below). 

7. Press the Save-F4 button. 
8. Repeat Steps 3 - 7 for each Sales Tax Code. 

Tax Percentage Example 

State County City Federal Total 

3.0000 1.5000 1.0000 0.0000 5.5000 

How Do I Set Up Customers? 

You must set up your customers before you can start tracking their 
Invoices, Balances, or Accounts Receivable. Follow the steps to 
create your customers.  

Step 1: Click on either the O/E or the A/R menu. 

Step 2: Next, select the Setup menu. 

Step 3: Click on the menu for Customer Maintenance. 
Complete all the required fields.  

 Important Note: If your customer is to be charged Sales Tax, 
make sure that you enter the appropriate Tax Code.  

Step 4: Press the Save-F4 button. 

Step 5: Repeat Step 3 for each Customer. 
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How Do I Enter Starting Balances for 
Customers? 

 

You can create A/R Transactions to record your customer balances 
as follows:  

1. Click on the A/R menu option. A/R is an abbreviation for 
Accounts Receivable.  

2. Next, click on Enter/Edit A/R Transactions & Payments 
option. 

3. Press Enter on the Edit Transaction Number field.  
4. Enter the Date for the transaction and press Enter. 
5. Click on Invoice for the transaction type and press Enter.  
6. Type the Customer ID and press Enter. 
7. Type the Invoice number and press Enter. 
8. Enter the Due Date for the transaction and press Enter. 
9. Type the amount of the balance owed in the Amount field 

and press Enter. 
10. For the transaction description type the words “Balance 

Forward” and press Enter. This is an optional step.  
11. If you have the G/L module, at this point the program will 

pre-fill the G/L Debit and Credit entries for you. You can 
change them if required or press the Save-F4 button. 

How Do I Track Sales Commissions? 

In order to track sales commissions, the following items must be 
setup: 

1. From the O/E menu select Setup and then select O/E Setup. 
Select the Commissions tab. Check the Box labeled “Activate 
Commission Tracking”. Change any other commission options 
if required. Click on OK-F4 to save. 
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2. From the O/E menu select Setup and then select Salesperson 
Maintenance. Enter and Save all your salespeople. This 
includes setting up their commission rate. If the commission rate 
of a salesperson varies for each inventory item, then leave the 
commission rate blank.  

3. From the Inventory menu, select Setup and then select 
Inventory Maintenance. Make sure each applicable item is 
marked as Commissionable in the Additional Information tab. 
In addition, if the commission rate is different for each item, then 
you can set it up over here in the Commission Amt or the 
Commission % fields. In most cases, you would leave these 
fields blank and set the commission rate in salesperson 
maintenance. You can also repeat this process for your Service 
Codes in Inventory menu. 

4. When you create your invoices from now you will be required to 
enter the Salesperson ID. After you save your invoices, you can 
run your Salesperson Commission report from the A/R, 
Reports menu.  

 Important Note: In the O/E Setup option (Step 1 in the 
previous section) you can choose if sales commission is calculated 
on the Selling Price, Cost of Goods, or Gross Profit Margin. As the 
default, the program will calculate commission on the Selling Price. 
However, if you change it to Cost of Goods or Gross Profit Margin, 
then only POSTED transactions will appear on this report. If a 
transaction you had created does not appear on this report, then 
check to make sure that the transaction has posted.  
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How Do I Set Up Vendors? 

You must set up your vendors before you can start tracking their 
Purchase Orders, A/P Invoices, or Balances. Follow the steps to 
create your vendors.  

1. Click on the P/O, Bank, or the A/P menu. 
2. Next, select the Setup menu. 
3. Click on the menu for Vendor Maintenance. Complete all 

the required fields.  

 Important Note: If your vendor charges you sales tax on a 
purchase order, make sure that you enter the appropriate Tax Code.  

4. Press the Save-F4 button. 
5. Repeat Steps 3 and 4 for each Vendor. 

How Do I Create Purchase Orders? 

You can create Purchase Orders for your Vendors to receive 
Inventory items and Services from them. When you receive and post 
these purchase orders, Inventory, and optionally A/P, are updated.  

1. Click on the P/O menu option. 
2. Enter the Date of the Purchase Order and press Enter. 
3. Enter the Vendor ID and press Enter. 
4. Make sure that the Ship to Address is correct and press 

Enter. 
5. Complete the PO header fields like FOB, Ship Via, etc. 

When you press Enter on the PO Description field, the 
cursor will go to the Item ID field.  

6. Enter the Item ID you wish to order and press Enter. The 
description of the item will show up. Then press Enter 
again. 

7. In the Ordered column, enter the number of units that you 
are ordering from the vendor and press Enter. 
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8. The price per unit should show up in the Unit Cost from 
inventory maintenance. If it does not then enter the price per 
unit and press Enter.  

9. At this point, the Tax and the Total fields are automatically 
updated.  

10. Repeat Steps 6 - 8 for each line item for this PO. Now you 
are ready to save this PO.  

11. You can save and print this PO by checking the “Print” box 
and then click on the Save-F4 button. Printing of the PO is 
optional. 

12. You can repeat Steps 2 - 11 to enter more Purchase Orders. 

How Do I Receive a Purchase Order? 

When you create and send a Purchase Order, you will receive the 
items from the Vendor. At that point, you must receive and post the 
Purchase Order to update Inventory and optionally the A/P module.  

1. Click on the P/O menu option. 
2. Click on the menu Enter/Edit Received Purchase Orders. 
3. Enter the number of the P/O that you are receiving in the 

Rcvd P.O. No. field. If you don’t know the PO number that 
you are trying to receive, you can click on the Browse 
button to look up the list of open POs. 

4. Make sure the information on the Received PO is correct 
(i.e. Date, Vendor ID, Ship to Address, and Due Date). Then 
click Enter on the PO Description field.  

5. At this point, you should be at the Item ID field. Click 
Enter to go to the Units column. Enter the number of units 
you received on this PO and click on Enter. 

6. In the Price column, type in the cost per unit and click 
Enter.  

7. Repeat Steps 5 & 6 for each line item on this Received PO. 
8. Enter any Freight for this PO and click Enter.  
9. Now you are ready to save this Received PO. You can print 

this Received PO by selecting the Print Received PO box 
and then clicking the Save-F4 button. 

10. Now that you have entered in your Received Purchase 
Orders, you can post them to update Inventory and A/P. 
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 Important Note: To update A/P, make sure you do the 
following first: From the P/O menu select Setup, and then select 
P/O Setup. Make sure there is a check for Create Unposted 
Transactions in A/P…, and then click on OK.  

11. Next, click on the P/O menu option. 
12. Click on the menu Post Received Purchase Orders. 
13. Enter the date you want it to post to and click the OK 

button.  
14. This will post your Purchase Orders and update inventory. In 

addition, an uposted bill will be created in A/P that you can 
pay later through the A/P menu.   

How Do I Enter and Pay A/P Bills? 

This will tell you how to enter bill to pay and how to pay them. 

You should first setup your Vendors as follows:  

1. Click on the menu A/P. 
2. Click on the Setup menu and select the menu option Vendor 

Maintenance. 
3. Enter a Vendor ID and press Enter. 
4. Complete the information for the vendor and click on the 

Save-F4 button. 
5. Repeat Step 3 & 4 for each vendor. 
6. At this point, you are ready to enter your bills and pay 

them. 
7. Click on the A/P menu. 
8. Click on the menu Enter/Edit A/P Bills & Credits. 
9. Type the Date for this transaction and press Enter. 
10. Type the Vendor ID and press Enter. 
11. Make sure the Invoice radio button is checked, and press 

Enter. 
12. Type the Invoice Number for the bill that you have received 

from the Vendor and press Enter. 
13. Type the Due Date for this bill and press Enter. 
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14. Enter the amount for this bill and press Enter. 
15. Enter the discount if any and press Enter. 
16. Press Enter until you get to the G/L Account ID column. 

This will bring up your Accounts Payable account number. 
Press Enter to continue.  

17. Enter a description for this transaction and press Enter. 
18. Make sure that it has the correct amount in the Credit 

column. If not, then type in the correct amount and press 
Enter. 

19. Next, go to the second line. You should be in the G/L 
Account ID column. This is where you need to enter the 
offsetting account. (The account to which the money is being 
debited, like an operation expense or an asset account. You 
can use the Browse-F3 to find the account you need). Click 
Enter to continue. 

20. Make sure that it has the correct Amount in the Debit 
column. If not, then type in the correct amount and click 
Enter. 

21. To save these transactions press the Save-F4 key. At this 
point, you have just entered a bill.  

22. You can now use the A/P Pay Bills (Auto or Manual) option 
to pay this bill with a check. 

23. Now you can update the General Ledger by posting the 
transaction. Click on the A/P menu. 

24. Click on the menu option Post A/P Transactions. 
25. In the Post Transactions to G/L to This Date.. field, make 

sure you type in the Date of the month that you want the 
transactions posted to G/L.  

26. Click on the OK-F4 button to Post to the G/L module. 

How Do I Set Up Inventory, Services, and 
Messages? 

If you create Invoices or maintain inventory, you must set up your 
Inventory Items, Service Codes, or Messages as follows: 

1. Click on the Inventory menu and click on the Setup option. 
2. Click on the option Inventory Maintenance. 
3. Complete the required fields.  
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 Be sure to mark the items as taxable if they are taxable. 
Press the Save-F4 button to save the item. 

 
4. Repeat Steps 3 and 4 for each Item. You can select Service 

Maintenance for services that you provide and Message 
Maintenance for messages that you can enter on in Invoice.  

 Important Note: You cannot edit the following fields from an 
inventory item: Average Cost, Unposted Returns, Units In Stock, 
Units on Order, Units on Backorder, Units for Sale, Units on PO, and 
On Hand Dollars. These fields must be adjusted by Receiving 
Purchase Orders or by using the Inventory Adjustment feature. 
For more information, please refer to page 136.  

How Do I Set Up Manufactured Items? 

Manufacturing feature is required for companies that maintain 
product kits or assemble inventory items from individual 
components. Here is how you can set up Manufactured Items. 

1. Click on the Inventory menu and click on the Setup option. 
2. Enter the Inventory ID and press Enter. 
3. It should show you the description and current units for this 

item. 
4. Click on the Manufacturing/Raw Materials tab. This 

should bring up the Raw Material Components screen. 
5. In the field titled Item ID for Raw Materials, enter the 

Item ID of the individual component that will be used to 
manufacture this item and press Enter. 

6. Enter the Units for each item and press Enter. 
7. Press the Save–F4 button to save it. 
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How Do I Enter Beginning Balances for 
Inventory? 

In order to update the Units in Stock and the Cost of the Units in 
Stock, you must use the Inventory Adjustment option. In addition, 
you can use this option to enter the starting balances for your 
inventory items. Here is how you can adjust an item. 

1. Click on the Inventory menu. 
2. Click on the menu for Inventory Adjustments and then 

select Enter/Edit Inventory Adjustments. 
3. Press Enter on the Transaction No field. 
4. For the Transaction Type, select Increase Inventory and 

press Enter.  
(You can also select Decrease or Replace Inventory if 
required). 

5. Type in the Date and press Enter.  

 Important Note: If you have G/L installed, this transaction is 
automatically posted to G/L for the date entered.  

6. Type the Description for this transaction and press Enter.  
7. Enter the Inventory Item ID and press Enter. It should show 

you the description and current units for this item. 
8. In the Adjust Quantity By, enter the total units you want to 

increase the Units in Stock field. After you enter this 
number, the New Units in Stock automatically display. 
Press Enter to continue. 

9. Type in the Unit Cost and press Enter.  
10. If you want to change the default selling price, type the Sell 

Price and press Enter. 
11. You can type in the other fields as required.  
12. When you are done, press the Save-F4 button to save the 

transaction.  
13. The Inventory file is updated automatically.  
14. You can repeat Steps 3 - 12 for other inventory items. 
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How Do I Set Up Departments in Payroll? 

If you track payroll for multiple departments then you should set up 
your department before entering any employees.  

1. Click on the Payroll menu. 
2. Click on the Setup menu and select the Payroll Setup menu 

option.  
3. Next, click on the Payroll Department Maintenance 

button. 
4. Type in the Department ID and press Enter. 
5. Type in the Department Name and press Enter. 
6. Press the Save-F4 button to save the new department.  

 Important Note: If you have the G/L module installed, the 
program will use the default chart of accounts for the Employee, 
Employer & Deductions. If you are using your own chart of 
accounts, you will need to change the account numbers to match 
your account list. 

7. Repeat Steps 4 - 6 for each department. 

How Do I Set Up and Issue Payroll Checks? 

 Important Note: For detailed and state-specific information 
about various tax codes, refer to your Readme file.  

Step 1: Select the Payroll Setup option from the Payroll/Setup 
menu. Set up your employee Deductions.  

Step 2: Select the Payroll Setup option from the Payroll/Setup 
menu. Select the Edit SUI/SDI/CA-ETT Rates option. 
Set up your employer contributions for these taxes if any. 
If your state has an employee contribution, the program 
automatically enters it for you. The employer contribution 
for this tax only applies to some states. If you are not 
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sure, contact your State Tax Board to determine your 
employer rate.  

Step 3: Select the Payroll Setup option from the Payroll/Setup 
menu. Select the Employees Maintenance option. 

Step 4: At the very minimum, enter the following Employee 
information: 

Personal Tab 

• Employee Name 
• Marital Status 
• Department ID (If you are not sure, enter the number 1) 
• Social Security Number  
• Tax Table ID 
• EIC (Earned Income Credit) Status 

Earnings Tab 

• Pay Frequency 
• Pay Type 
• Regular and Overtime rate if Employee is Hourly or 

Annual Salary for Salaried or Commission Base for 
Commissioned employees.  

Withholdings Tab 

• Enter the Federal and State Exemptions based on what the 
employee is claiming on the W-4 Form. 

• If your city or county charges income tax, enter the City 
Rate. (NY City residents do not have to do this). If you are 
not sure about the city/county income tax, contact your 
city/county officials for more information. 

• Fill up other fields as required. 

Step 5: From the Payroll menu, select the Auto Process Payroll 
Checks and then select the Auto Pay Payroll Checks 
option. The program will automatically present one 
employee at a time. After typing in the hours, press the 
Next key to go the next employee. After all the 
employees are processed, you will be able to print the 
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Payroll Worksheet report and then print the Payroll 
Checks. 

Step 6: Select the Post Payroll option to from the Payroll menu. 
This will post the payroll checks.  

Step 7: At this point your Payroll processing is complete. You 
can print your Payroll reports from the Reports menu.  

How Do I Set Up and Use Job Tracking? 

Step 1: From the Job menu, select the Setup menu option. Check 
the Activate Job Tracking option and click on the OK 
button.  

Step 2: From the Job menu, select the Job Maintenance menu 
option. Complete the fields for the job. At the very 
minimum, you should enter the information for the Job 
ID and the Description fields. Click on the Save-F4 
button to save the information. Repeat this Step for all 
your jobs. 

 The Job ID is a required field on all your transactions. 
Sometimes you may not want to enter in a Job ID for a transaction. 
For such situations, you can create a “dummy” Job ID like the 
number 99. You can then use the number 99 on all transactions on 
which you do not want to enter a Job ID. 

Step 3: When you create an invoice in Order Entry, you will be 
required to enter a Job ID. When you post the invoice, 
the Income portion of the job will increase 

Step 4: When you create an A/P Transaction or write a check via 
the Bank Manager, you will be required to enter a Job 
ID. When you post these transactions, the Expense 
portion of the job will increase. 
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Step 5: From the Job menu, select the Job Profitability 
Statement menu option. In the Job ID field, enter the ID 
of the job for which you wish to obtain the profit. Make 
sure you select the correct date range. Click on the OK 
button to print the report. 

 Important Note: Only POSTED transactions will appear on 
this report. If a transaction you had created does not appear on this 
report, then check to make sure that the transaction posted and it had 
the correct Job ID on it.  

How Do I Enter Beginning Balances for 
Property Management? 

This section is designed to get you quickly up and running with 
Property Management. It will walk you though the steps of creating 
Buildings, Units, and Tenants. It will also show you how to enter the 
monthly rents and the previous balances for your tenants. If you have 
detailed questions about a specific screen, you may refer to the 
appropriate section in the Property Management chapter. 

Step1: From the P/M menu, select the Setup menu and then 
select the Building Maintenance option. In the Building 
Maintenance screen, at the very minimum type the 
Building ID and the Building Name for each of your 
buildings or apartments.  

Step 2: From the P/M menu, select the Setup menu and then 
select the Unit Maintenance option. On the Unit 
Maintenance screen, at the very minimum type the 
Building ID, Unit ID, Rent, and the Period for which 
the rent is charged. Repeat this for all the units in each of 
your building(s).  
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Step 3: From the P/M menu, select the Setup menu and then 
select the Tenant Maintenance option. On the Tenant 
Maintenance screen at the very minimum type the 
Tenant ID, and the Tenant Name.  
 

 Important Note: If you wish to create a separate income 
statement for each building, you must type the Building ID (which 
this tenant will occupy) in the Department field. If prompted to add 
the Department, select YES and add the Department ID. For more 
details, please refer to Tracking Income by Building section in the 
Property Management chapter. 

Step 4: When you have completed the information on the tenant 
maintenance screen, click on the OK Button. You will be 
asked the following question – Tenant saved, move in 
now? If you wish to move the tenant into a unit, answer 
with a Yes. If you do not wish to move the tenant, answer 
with a No. You can always move a tenant in to a unit later 
by using the Move Tenant In menu option.   

Step 5: If you had answered the move-in question with a Yes, 
you will be presented with a Move Tenant In screen. 
Complete all the fields on the screen. Make sure you type 
in the Building ID and the Unit ID, which this tenant 
will occupy.  

Step 6: Next, you will be asked to enter Recurring Charges. An 
example of a Recurring Charge is RENT. You can enter 
the Description, Amount, Period and the Next Due date 
on which this charge is to be applied. Make sure you 
enter the date as the next month’s date. We will enter 
any past balances for tenants in a later step. You can enter 
multiple charges for each tenant. To do this, simply press 
the Next button. When you have entered the RENT 
information for the tenant, press the Save-F4 button. 

Step 7: You will now be asked if you wish to receive a deposit 
from this tenant. If you wish to receive a deposit, answer 
with a Yes. If you do not wish to receive a deposit, 
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answer with a No. You can always enter a deposit later by 
using the Enter/Edit Tenant Transactions menu option. 

Step 8: If you had answered the Deposit question with a Yes, the 
Enter/Edit Tenant Transactions screen will display 
now. Complete all the fields on the screen, including the 
deposit amount. When you click on the Save-F4 button, 
you can print a receipt if required.  

Step 9: Repeat Step 3 to Step 8 for each tenant.  

Step10: After you have saved all your tenants, you can now enter 
any balances that they owe from the past. To do this, 
select the Enter/Edit Tenant Transactions screen. 
Leave the Transaction Number empty and press Enter. 
Next, change the Transaction Type to One-Time 
Charge. Type the Tenant ID, the Date of the last charge 
owed, Description and the Amount owed. Press the 
Save-F4 button. Repeat this process for all the tenants 
that owe past balances. 

 If the tenant had a credit balance from the past, 
then you can enter the amount as Credit Adjustment.  

Step 11: At this point you can print your reports from the P/M 
Reports menu 

How Do I Set Up the TimeCard Module? 

The TimeClock is typically used in a network environment. 
However, you can also use it for a single employee with a single user 
version. To use the TimeClock function, you need to enable the 
Security/Password option.  
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To do this, select File from the upper left hand corner of your entry 
screen. Next, click on Company Settings and select the Options tab. 
Place a checkmark in Enable Password Protection. 

If you have not already set up passwords for your employees, you 
can do that by selecting User and Password Setup from the 
Company Settings option. 

Once you have completed the set up and the user logs in, the 
program automatically identifies them. The user can go to the 
TimeClock screen to clock in or to clock out.  

 Important Note: If you will not be using this function, skip 
this section and go the next section. 

The TimeClock option will work in one company only. If you have 
multiple companies, you will need to set up a new base company for 
TimeCard. 

Here is the series of steps to set up the TimeClock functions: 

Step 1:  If you have multiple companies set up, make sure that 
you are logged into the company where you want to 
store the ClockIn or ClockOut hours for your employees. 
You can select the company from the File > Open 
Company option. 

Step 2:  From the TimeCard menu, select Setup and then select 
the Timecard Setup option. Set the default settings that 
apply to you. There are two important setting here. 
These are at the bottom of the Timecard Setup screen:  

• Synchronize Time: When an employee clocks in or clocks 
out, the TimeClock needs to record the date and time. This 
information is obtained from your employee’s local 
computer. To synchronize the times, enter the name of the 
server computer in the input field Synchronize time…  



144  ••   Quick Start Guide Accounting for Windows 

 Important Note: If an employee changes the date or the time 
on their computer, they could manipulate their timecard entries. That 
is why we recommend that you synchronize the date/time on the 
employee’s computer with another computer  usually the server. 
This synchronization is done automatically, each time the employee 
clocks in or out.  

 If you do not know the name of the server, do the following: 
Go to the server computer and select Start > Settings > Control 
Panel > Network icon. When the Network properties display, click 
on the Identification tab. The name of the computer displays in the 
Computer Name text box. 

• Use This Company: Select the company name that you will 
use to store the TimeClock entries for the employees when 
they clock in or clock out. You will find this aspect useful if 
you have multiple companies. It allows the employee to be 
working with any company and still use the 
ClockIn/ClockOut option to record their time in one 
location.  

Step 3:  From the TimeCard menu, select Setup and then select 
the Employee Maintenance option. Set up your 
employees here. The TimeCard program shares the 
employee file/database with the Payroll module.  

If you also have the Payroll module installed, your 
employees’ information will be available to the 
TimeCard module and you only need to use the 
Employee Maintenance screen for editing time-card- 
specific settings. 

Step 4:  For this step, log in as the system administrator. From 
the File menu, select Company Settings and then select 
Company Setup. Select the options tab and then check 
the Enable Password Protection checkbox. Click on 
the Save-F4 button. Next, from the File menu, select 
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Company Settings and then select User & Password 
Setup. Click on the  button to add a new user.  

If you have already added the users before, then you will 
select Edit. In the Modules tab, make sure that the 
TimeCard box is checked. Then click on the TimeCard 
tab and click on the options that the employee will be 
able to access within this module.  

If an employee will be using the TimeClock screen to 
ClockIn or ClockOut, make sure that TimeClock 
ClockIn/ClockOut box is checked. In addition, you 
must type in the Employee ID for each employee from 
the Employee Maintenance option. This is necessary 
for the program to properly identify the employees when 
they clock in or clock out. 

Your TimeClock setup is now complete. Your employees will now 
only need to do the following: 

1. Start the VersaPro 2001 Accounting program. 
2. Log in with their User ID and Password. 
3. Select the TimeCard menu and then select the 

TimeCard ClockIn/ClockOut option. 
4. Click on the Clock In or the Clock Out button at the 

bottom of the screen. 

 Important Note: If you have typed the server name in the 
Synchronize time... field in Step 2, the employee will see a black 
window displaying for a brief moment each time they click on the 
Clock In or the Clock Out button. This means the date/time on the 
employee’s local computer is being synchronized with the server. 
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How Do I Enter Beginning Balances for 
Checkbook? 

 To enter the starting balance for the checkbook click on the menu 
option Bank. 

1. Click on the menu Enter/Edit Checkbook. 
2. Choose Deposit from the drop down box as the Transaction 

Type and press Enter. 
3. Enter the optional Vendor information. If no vendor is 

needed, press Enter until the cursor gets to the Date field. 
Enter the correct date and press Enter. 

4. In the field with the word “Amount” on the left-hand side, 
you need to enter the amount of the beginning balance and 
press Enter. 

5. In the Memo field, you can enter a memo if you would like 
to, and press Enter. 

6. In the Reference field add a reference number if needed and 
press Enter.  

7. In the Checking Account field, make sure that you have the 
right checking account number (from the chart of accounts) 
that you wish to have the deposit entered into and press 
Enter. 

8. In the Disbursement field, enter the account number from 
which the money came from – such as account #31010 
Owners Equity, or any other Capital/Equity account. 
Owner’s Equity would be an example of an Owner starting a 
company with their own money (out of pocket). Press Enter 
to continue. 

9. Once you have completed filling out the form click on the 
Save-F4 button.  

 You can repeat the steps above for any other checking 
accounts, savings accounts, or any other bank account that needs a 
beginning balance. 
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At this point, you have saved the transaction and updated you chart 
of accounts with a beginning balance. 
 

10. Make a backup using the Backup button on the toolbar. 
11. From the Bank menu, select the Post Checkbook menu 

option. 
12. In the Post Transactions to G/L to This Date... field, make 

sure you type in the date for the month you want to post 
these transactions to G/L.  

13. Click on the OK-F4 button to post to the G/L module. 

How Do I Enter Beginning Balances for G/L 
Accounts? 

If you are using General Ledger, follow these steps: 
 

1. Enter, verify, and post starting balance information in all 
the modules (like Bank Manager, Customers, Vendors, 
Inventory etc.) other than G/L. It is very important to verify 
and then post the information before going to the next step. 
The steps to enter information for each module are listed 
later on in this document.  
 

2. After you have entered and posted information for the other 
modules, print your G/L Balance Sheet and Income 
Statement.  

 
Often, because of the posting in step 1 above, these balances may 
not match your actual Balance Sheet or Income Statement. In such a 
situation you must make Adjusting Journal Entries to correct the 
account balances. You can make adjusting entries using the 
Enter/Edit G/L Transactions option in the G/L menu. You can 
enter G/L Transactions as follows: 
 

3. From the main screen of the program, click on the G/L 
menu. 

4. Select the Enter/Edit G/L Transactions option. 
5. Once the G/L transaction screen opens, type JE in the 

Journal Source field and press Enter.  
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 Do not use AP, OE, PY, AR, CK, IV, or PO in this field. 
These “codes” are reserved for use by the program exclusively.  
 

6. Enter the Journal Date you want for this transaction and
 press Enter. 
7. At this point, the cursor should now be in the “Account ID” 

column. Type in an account number (such as 11010 for 
checking). If you do not know the account number click on 
the Browse-F3 button to view a list of accounts. (If you 
clicked on the Browse-F3 button, select the account you 
wish to make the entry and press the OK-F4 key or double 
click on the desired account).  

8. After selecting the account, the account number should show 
up in the Account ID column. If it does then press Enter.  

9. If the account appeared in the column and you pressed enter 
your cursor should now be in the description field. In this 
field, you may type the nature of the transaction such as the 
words  “Beginning Balance”. You may abbreviate it by 
typing “Beg. Bal.”  

10. Once you have entered your description, press Enter to 
move to the Debit column. (Pressing Enter again will take 
you to the Credit column.). Type in the Amount of the debit 
or credit followed by pressing Enter.  

11. Move to the Account ID column on the next line down 
using your arrow keys on your keyboard (Or you can use the 
Enter key).  

12. On this line, you make the offsetting entry to create the “in 
balance” situation. Please refer to a sample of a double-
ended entry at the end of these steps.  

13. Repeat steps 4 - 9 as necessary to enter beginning balances 
on the remainder of your accounts requiring a beginning 
balance.  

14. Once you have completed filling out the form, click the 
Save-F4 button. 

15. At this point, you have saved the transaction and updated 
you chart of accounts with a beginning balance. 

16. Make a backup using the Backup button. 
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Sample double-ended entry:  

Account Account 
Name 

Description Debit Credit  

11010 Checking Beginning 
Balance 

$1000  

31010 Owners 
Equity 

Beginning 
Balance 

 $1000 

  Totals $1000 $1000 

Commonly Used Terms in General Ledger  

• Debit: Application of Money (+)   
• Credit: Source of Money (-)   

How Do I Backup My Data Files? 

Data backup is a very important process. Not backing up data is like 
driving your vehicle without insurance. We recommend that you 
back up after each session of data entry or before posting. In 
addition, keep multiple sets of backup disks and rotate through these 
sets. Here is how you can back up your data. 

1. Select the File menu. 
2. Next, select the menu for Data Utilities.  
3. Select the menu for Backup Data Files.  
4. If you are backing up to a drive other that A:, change the 

drive letter and then click on the OK button. 

How Do I Restore My Data Files? 
1. Select the File menu. 
2. Next, select the menu for Data Utilities.  
3. Select the menu for Restore Data Files.  
4. If you are restoring from a drive other that A:, then change 

the drive letter and then click on the OK button. 



150  ••   Quick Start Guide Accounting for Windows 

How Do I Set Up Preprinted Forms? 

This program supports various styles of forms (Invoices, Checks and 
Statements). When you go to print any form like a check, you can 
select the appropriate Form Style at that time. 

You can order the Preprinted Forms like checks, invoices, 
statements, W-2, and 1099 forms from our national supplier ZLand 
Forms.  

 Important Note: This program is designed to print on forms 
supplied by ZLand Forms only. You may have alignment problems 
with forms supplied from a different manufacturer. We guarantee 
compatibility only with forms supplied by ZLand Forms. 

Please refer to the on-line Forms Brochure included with the 
program for information on ordering forms or FREE 
SAMPLES. You can order the Preprinted Forms like checks, 
invoices, statements, W-2, and 1099 forms from our national 
supplier ZLand Forms. For placing an order or obtaining FREE 
FORM SAMPLES, ZLand Forms can be reached at  

(800) 2-BUY FORMS 

How Does Reindexing Work?  

Just as you use the index at the back of this manual to quickly search 
for information, the program uses index files to locate your data.  

Some times the index files can become corrupted due to a variety of 
reasons. Some of the most common reasons are rebooting, or 
shutting windows without exiting the program, hard disk problems, 
incorrect system set up (low RAM/memory), and so on. As a result, 
the program might give you an error message or not furnish correct 
information.  
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You can reindex as follows.  

1. Click on the File menu. 
2. Select the Data Utilities menu.  
3. Next, select Reindex Data Files menu option. 
4. Click on the YES button. This will reindex your data files.  

 Important Note: Reindexing should be done once a month if 
you are not putting in a lot of data. Reindexing should be done once 
a week if you are putting in a lot of data. 

How Do I Print to the Correct Printer? 

You can select your printer in two ways: 

1. Select the Printer Setup option from the File menu to bring 
up the standard Printer Setup window. 
 

2. At the time of printing your reports, do the following: 

Step 1: Select your report output to go to the Printer. 

Step 2: A Printer Setup button is enabled at this point. 
Click on this Printer Setup button to select the 
printer. 

 Important Note: As this program uses the standard printer 
drivers that are available with Windows, refer to your Windows 
manual for more information on Printer Setup. 

How Do I Send E-Mail? 

You can use the Send Mail option from the File menu to send mail 
to another user. The Send Mail option invokes the Microsoft 
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Exchange or the Microsoft Outlook program. In addition, you 
when you go to print most of your reports, you can send the report to 
Microsoft Exchange or Microsoft Outlook instead of your 
sending it to the printer. The report is sent as a text file attachment to 
your e-mail. 

Please refer to your documentation supplied by Microsoft on using 
Microsoft Exchange or Microsoft Outlook.  

 Important Note: You must have Microsoft Exchange or 
Microsoft Outlook installed and running to use this option within 
this program.  


